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Contacting RUCKUS Customer Services and Support

The Customer Services and Support (CSS) organization is available to provide assistance to customers with active warranties on their RUCKUS
products, and customers and partners with active support contracts.

For product support information and details on contacting the Support Team, go directly to the RUCKUS Support Portal using https://
support.ruckuswireless.com, or go to https://www.ruckusnetworks.com and select Support.

What Support Do | Need?

Technical issues are usually described in terms of priority (or severity). To determine if you need to call and open a case or access the self-service
resources, use the following criteria:

®  Priority 1 (P1)—Critical. Network or service is down and business is impacted. No known workaround. Go to the Open a Case section.

e  Priority 2 (P2)—High. Network or service is impacted, but not down. Business impact may be high. Workaround may be available. Go to
the Open a Case section.

e  Priority 3 (P3)—Medium. Network or service is moderately impacted, but most business remains functional. Go to the Self-Service
Resources section.

e  Priority 4 (P4)—Low. Requests for information, product documentation, or product enhancements. Go to the Self-Service Resources
section.

Open a Case

When your entire network is down (P1), or severely impacted (P2), call the appropriate telephone number listed below to get help:
e Continental United States: 1-855-782-5871
e Canada: 1-855-782-5871

e  Europe, Middle East, Africa, Central and South America, and Asia Pacific, toll-free numbers are available at https://
support.ruckuswireless.com/contact-us and Live Chat is also available.

e  Worldwide toll number for our support organization. Phone charges will apply: +1-650-265-0903

We suggest that you keep a physical note of the appropriate support number in case you have an entire network outage.
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Contact Information, Resources, and Conventions
Document Feedback

Self-Service Resources
The RUCKUS Support Portal at https://support.ruckuswireless.com offers a number of tools to help you to research and resolve problems with your
RUCKUS products, including:

o  Technical Documentation—https://support.ruckuswireless.com/documents

e  Community Forums—https://community.ruckuswireless.com

e  Knowledge Base Articles—https://support.ruckuswireless.com/answers

e  Software Downloads and Release Notes—https://support.ruckuswireless.com/#products_grid

®  Security Bulletins—https://support.ruckuswireless.com/security

Using these resources will help you to resolve some issues, and will provide TAC with additional data from your troubleshooting analysis if you still
require assistance through a support case or RMA. If you still require help, open and manage your case at https://support.ruckuswireless.com/

casefmanagement.

Document Feedback

RUCKUS is interested in improving its documentation and welcomes your comments and suggestions.
You can email your comments to RUCKUS at #Ruckus-Docs@commscope.com.
When contacting us, include the following information:
e  Document title and release number
e  Document part number (on the cover page)
e  Page number (if appropriate)
For example:
e  RUCKUS SmartZone Upgrade Guide, Release 5.0
e  Part number: 800-71850-001 Rev A
e Page7

RUCKUS Product Documentation Resources

Visit the RUCKUS website to locate related documentation for your product and additional RUCKUS resources.

Release Notes and other user documentation are available at https://support.ruckuswireless.com/documents. You can locate the documentation by
product or perform a text search. Access to Release Notes requires an active support contract and a RUCKUS Support Portal user account. Other
technical documentation content is available without logging in to the RUCKUS Support Portal.

White papers, data sheets, and other product documentation are available at https://www.ruckusnetworks.com.

Online Training Resources

To access a variety of online RUCKUS training modules, including free introductory courses to wireless networking essentials, site surveys, and
products, visit the RUCKUS Training Portal at https://commscopeuniversity.myabsorb.com/. The registration is a two-step process described in this
video. You create a CommScope account and then register for, and request access for, CommScope University.
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Contact Information, Resources, and Conventions
Command Syntax Conventions

Document Conventions

The following table lists the text conventions that are used throughout this guide.

TABLE 1 Text Conventions

monospace Identifies command syntax examples device (config)# interface ethernet 1/1/6

bold User interface (Ul) components such On the Start menu, click All Programs.
as screen or page names, keyboard
keys, software buttons, and field
names

italics Publication titles Refer to the RUCKUS Small Cell Release Notes for more information.

Notes, Cautions, and Safety Warnings

Notes, cautions, and warning statements may be used in this document. They are listed in the order of increasing severity of potential hazards.

NOTE
A NOTE provides a tip, guidance, or advice, emphasizes important information, or provides a reference to related information.

ATTENTION
An ATTENTION statement indicates some information that you must read before continuing with the current action or task.

CAUTION
A A CAUTION statement alerts you to situations that can be potentially hazardous to you or cause damage to hardware, firmware,
software, or data.

DANGER
A A DANGER statement indicates conditions or situations that can be potentially lethal or extremely hazardous to you. Safety labels are
also attached directly to products to warn of these conditions or situations.

Command Syntax Conventions

Bold and italic text identify command syntax components. Delimiters and operators define groupings of parameters and their logical relationships.

Convention Description

bold text Identifies command names, keywords, and command options.
italic text Identifies a variable.

[1 Syntax components displayed within square brackets are optional.

Default responses to system prompts are enclosed in square brackets.

{x|yl z} A choice of required parameters is enclosed in curly brackets separated by vertical bars. You must select one of the options.
x|y A vertical bar separates mutually exclusive elements.
<> Nonprinting characters, for example, passwords, are enclosed in angle brackets.

Repeat the previous element, for example, member[member...].

\ Indicates a “soft” line break in command examples. If a backslash separates two lines of a command input, enter the entire command at
the prompt without the backslash.
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About This Guide

©  NEW iN THiS DOCUMEBNL.....cuviitiietieeieeteeete ettt ete et e steestaeeste e aeeeteeesseessaesseessseesseesseessaessassseasssesssaasseasseenssensseseeesseenseenseesssennseanses

New in This Document

TABLE 2 Key Features and Enhancements in SmartZone 7.0.0 Rev A (February 2024)

No new features are added in this release. Not Applicable Not Applicable
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Guest Passes

Guest passes are temporary privileges granted to guests to allow access wireless LANs.

Many options are provided for customizing guest passes, controlling who is allowed to issue guest passes, and controlling the scope of access to be
granted.

With Guest Pass authentication enabled, guests are required to enter a guest pass code when connecting to a guest WLAN. Temporary guest passes
can be issued for single user, multiple users, one-time login, time-limited multiple logins for a single guest user, or can be configured so that a single
guest pass can be shared by multiple users. Additionally, they can be batch generated, if many short-term guest passes must be created at once.
Guest passes can be generated in two ways:

e  Self-Service Generated Guest Passes

o  Admin Generated Guest Passes
After generating a guest pass, they can be delivered in the following ways:

e  Printout

e Send SMS with guest credentials

o  Send email with guest credentials

NOTE

To enable guest pass delivery through email or SMS, you must first configure an email server or an SMS delivery account (Twilio or
Clickatell) from the Email tab or the SMS tab (Services > Hotspots & Portals > Guest Access .

FIGURE 1 Guest Access

@ |#* Monitor 5 Network U security & services & Administration 13 search menu @ Ruckus Analytics

GuestAccess  Hotspot (WISPr)  Hotspot20  WebAuth  UABlacklist  Portal Detection & Suppression  WeChat

Name a Description
- B system

AISH GUEST PORTAL N/A

NT N/A

ORGANIZATION

fal
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Guest Pass

SmartZone Guest Pass Self Registration

Currently Smart Zone Guest Access solution relies on assisted guest pass generation, which means IT or hotel staff needs to generate guest

password to the client based on whatever credentials needed. To make the process simpler and for ZD parity, this feature is to make guest self-
registration a possibility on SZ, so that steps can be configured and displayed on guest UE to guide them through a step by step process to obtain a
key for the guest WLAN access.

Self-service guest pass registration only applies to guest access WLAN.

Complete the following steps to create a self registration guest pass:

1.
2.

On the menu, click Services > Hotspots & Portals > Guest Access to display the Guest Access window.

In the Organization tab, select the zone for which you want to create the guest access portal.

. + Create . .
Click Icon to display the Guest Access Portal dialog box.

In the Guest Access tab, switch ON the Self-registration option and follow the guest pass registration process, refer to Creating a Guest
Access Portal.

FIGURE 2 Self Registration

Create Guest Access Portal

General Options a

Portal Name: ‘ ‘

Portal Description:

Language: ‘ English |

Redirection

Start Page: After user is authenticated,
(®) Redirect to the URL that user intends to visit. | | Redirect to the following URL:

Guest Access

Self-registration: m
@ o

Guest Pass SMTP Server: (( Jeidd

Guest Pass SMS Gateway: ‘ Disabled

If the sponsor approval is disabled, when end-user connects to the WLAN, user can finish the registration and get the guest password automatically

without any approval.

12
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Admin Generated Guest Passes

Guest passes allow temporary access to wireless LANs.

Step 1: Create a Guest Access Service

1. To create a guest access service in the Guest Access Portal, refer to Creating a Guest Access Portal.

2. When you finish creating a guest access service, continue to Step 2: Create a Guest Access WLAN on page 13.

Step 2: Create a Guest Access WLAN

Guest passes are generated for specific WLANs only. Guest pass users will only be able to gain access to the WLANSs for which the guest pass is
generated.

Follow these steps to create a WLAN that will be used for guest access only.

1.  On the menu, click Network > Wireless > Wireless LANs to display the Wireless LANs window.

* | Monitor &% Network U security O Services & Administration " © Ruckus Analytics 3 W Wireless LANs.
Wireless LANs wewnooe: | List | Group
+ £ [ X More fs 2R ¢ More. search table Q [sX -]
Name a Hlerts ssD Auth Method EncryptionMethod  Clients Traffic VLN Tunn Statu
. - nsys(am
2 + &80 AISH-6.1.1-802.1X 0 AISH-6.1.1-802.1X 802.1X weA2 0 0 6 Disabled APBridg... @
g
] .
H & AISHS. AISH-6.1.1-DHCP-NAT 0 AISH-6.11-DHCP-NAT  OPEN NONE 0 0 6 Disabled APBridg... @
g + AISHE 7 . , N
= AISH-6.1.1-GUEST 0 oPEN NONE 0 0 76 Disabled APBridg... @
+ AlSH 1
N ASH- €8 0 oPEN NONE 0 0 76 Disabled APBridg... @
+ AISH-6.1.1-WISPR+802.1X 0 AISH-6.1.1-WISPR#8...  802.1X wPA2 0 0 76 Disabled ApBridg... @
- AISH-6.1.1-WISPr+MAC 0 MAC NONE 0 0 6 Disabled APBridg... @ d
= =
. AISH-ALEXA 0 AISH-ALEXA opEN NONE o o 27 Disabled ApBridg... @ g
AISH-MLISA-802.1X 0 AISH-MLISA-802.1X 802.1X wPAZ 0 0 27 Disabled APBridg.. @ d
3
18 records 123 »
Traffc  Configuration ~ Alarm  Event  APs  Clients  Senvices  Administrators
g
2
i
a Historical Time Traffic £ Refresh
Traffic o8
Clients o8
ce

2. Inthe Organization tab, select the zone from the group list for which you want to create the Wireless LANs. If you want to create a group,
refer to Creating a WLAN Group in the WLAN Management Guide.
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== Creste
3. Click = Icon to display the Create WLAN Configuration dialog box.

FIGURE 4 Create WLAN Configuration

Create WLAN Configuration

General Options
Authentication Options
Encryption Options
Data Plane Options
Accounting Service
Wireless Client Isolation
RADIUS Options
Firewall Options

Advanced Options
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4. Inthe Authentication Options tab, select Guest Access option to displays the Guest Access Portal tab.

FIGURE 5 Guest Access Portal

Create WLAN Configuration

General Options

Authentication Options

Authentication Type: () Standard usage (For mast reqular wireless () Hotspot (MISPr) () Web Authentication

networks)

) Hotspot 2.0 Access () Hotspot2.0 Onboarding | WeChat

Method: (@) Open_ 802.1X EAP

Encryption Options

Data Plane Options

Guest Access Portal

Wireless Client Isolation

RADIUS Options

Firewall Options

Advanced Options
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5. Complete the following fields:

FIGURE 6 Guest Access Portal: Guest and Always Accept

Create WLAN Configuration

Guest Access Portal

Guest Authentication: Guest Always Accept Guest Access / Social Media Login Social Media Login
Guest Portal Service: | Select a guest access | +
Bypass CNA: m
Portal Detection & Suppression: | System Default | +

Guest Accounting: Use the controller as proxy
| Disable | +

FIGURE 7 Guest Access Portal: Guest Access/Social Media Login and Social Media Login

Guest Access Pertal
Guest Authantication; Guest (| Ahways Accept (8] Guest Access [ Social Media Login || Social Media Login
Soclal Media Profile: | Select a social media +
Guest Partal Sepvies: | INT + &
Bypass CHA: m
Portal Detection & Suppressient | System Default o=
Guast Aecounting: (E Use the controller as prosgy
Disahla +

o  Guest Authentication: Select from the below option.

- Guest: Provides guest-level access only.

- Always Accept: Allows users without guest credentials to receive authentication.

- Guest Access / Social Media Login: Configures a guest-level access or social media profile.

- Social Media Login: Configures social media profile for a user, use client ID and client secret options.

o  Guest Portal Service: Select the guest access from the drop-down list or click * icon to create a new guest access portal, refer to
the Creating a Guest Access Portal.

NOTE
Click d icon to modify the selected guest portal service.

e  Bypass CNA: By default, this option is ON, turn it OFF to disable this option.

e  Portal Detection & Suppression: This option is available only when the Bypass CNA is ON. Choose from the drop-down list or click

+ icon to create a new portal detection profile, refer to Creating a Portal Detection and Suppression Profile on page 71.

NOTE

Click d icon to modify the selected portal detection & suppression.

RUCKUS SmartZone (ST-GA) Guest Access Guide, 7.0.0
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o  Guest Accounting: By default, this option is OFF, turn it ON If you want to use the controller as proxy. Choose from the drop-down list

or click + icon to create AAA server, refer to Creating Non-Proxy Authentication AAA Server.
NOTE

Click 4 icon to modify the selected guest accounting.

e Social Media Profile: This option is available only when you select Guest Access / Social Media Login or Social Media Login in the
Guest Authentication. Choose from the list or follow these steps to create a new social medial login profiles.

a. Inthe Social Media Profile field, click + icon to display the Create Social Media Login Profile dialog box.

FIGURE 8 Create Social Media Login Profile Dialog Box

Create Social Media Login Profile

General Options

Name:

Descriplion:

Social Auth Option

Sochal Media Logins:  Linkedin: m
Gaoogle: m

Microsoft: .EIFF
Facebook: {E

Whitslizt=d Domain <= Add Import CSV ¥ Cancel

b. Complete the following fields:

- Name: Type a name for the social media profile that you are creating.
- Description: Type a short description of the social media profile.
- Social Media Logins: Select the required social media from the list. Switch ON to create a social media login.

y Linkedin: Enter the Client ID and Secret.

RUCKUS SmartZone (ST-GA) Guest Access Guide, 7.0.0
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FIGURE 9 Social Media Logins: Linkedin

Social Media Logins: Linkedin: m

Input existing client ID/secret or click here to generate one

LinkedIn Client ID:

LinkedIn Secret:

Example whitelisted domains: *.licdn.com, *.linkedin.com

To create a new Client ID and Secret for Linkedin, click here or refer to https://developer.linkedin.com/.
Google: Enter the Client ID and Secret.

FIGURE 10 Social Media Logins: Google

Social Media Logins: LinkedIn:

Input existing client ID/secret or click here to generate one

Google Client ID:

Google Secret:

Example whitelisted domains: *.geotrust.com, *.google.com, *.gstatic.com

To create a new Client ID and Secret for Google, click here or refer to https://console.cloud.google.com/
projectselector2/apis/credentials.
Microsoft: Enter the Client ID and Secret.

FIGURE 11 Social Media Logins: Microsoft

Social Media Logins: LinkedIn:
Google:
Microsoﬁ::m

Input existing client ID/secret or click here to generate one
Microsoft Client ID:

Microsoft Secret:

Example whitelisted domains: *.geotrust.com, * live.com, *.microsoftonline.com, auth.gfx.ms, *.msauth.net,
*.gstatic.com

To create a new Client ID and Secret for Microsoft, click here or refer to https://portal.azure.com/#view/
Microsoft_AAD_RegisteredApps/ApplicationsListBlade.
Facebook: Enter the Client ID and Secret.
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FIGURE 12 Social Media Logins: Facebook

Social Media Logins: LinkedIn:
Google:
Microsoft: ((Joaa
Facebook:

Input existing client ID/secret or click here to generate one

Facebook Client ID:

Facebook Secret:

Example whitelisted domains: *.facebook.com, fbcdn-profile-a.akamaihd.net, fstatic-a.akamaihd.net,
* fbedn.net

To create a new Client ID and Secret for Facebook, click here or refer to https://developers.facebook.com/.

Add
> Whitelisted Domain: Add the domain names and click F A icon to add the External Portal domain or click Import
CSV to import the domain name using the CSV file. The added domain names are displayed in the Whitelisted Domain
table.

c. Click OK.
6. Click OK.

7. Inthe Wireless LANs window, select a user name from the table. Click More > Enable icon to enable the user or click More > Disable icon
to disable the user.

NOTE
You can also edit, clone, and delete a Wireless LANs by selecting the options Configure, Clone, and Delete respectively, from the Wireless
LANs window.

RUCKUS SmartZone (ST-GA) Guest Access Guide, 7.0.0
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Step 3: Generate a Guest Pass
Follow these steps to generate a guest pass.

1. On the menu, click Security > Access Control > Guests > Guests Pass to displays the Guest Pass window.

FIGURE 13 Guest Pass

- & Monitor < Network U security & services & Administration * © All New Analytics C 6 Guest Poss

GuestPass  Guest Pass Template

Self-Service Generated Guest Passes

More. Y Fitteroff | | searchtable Q) Tw

GuestName a. Role Manage B Key Emai Phone Generated Expiration Date LAN Api

ORGANIZATION

Admin Generated Guest Passes

ck Import Guest Pass.

MOU 1BUD

& GenerateGuestPass || 1, Import GuestPass

More Y FilterOff & | searchtable Q c8

GuestName a ManageB, Key Remarks Generated Expiration Date WLAN

Nodata 1
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2. Inthe Admin Generated Guest Passes tab, click Generate Guest Pass to display the Generate Guest Pass dialog box.

FIGURE 14 Generating a guest pass

Generate Guest Pass

Guest Name:

Guest WLAN: | [ruckus] of [RUCKUS]

Humber of Passes: | 1

Pass Valid For: 1

Advanced Options

Pass Generation: Auto Generate

Pass Effective Since: (@) Effective from the creation time

() Effective from first use

Max Devices Allowed: (@) Limitedto | 1
() Unlimited

Remarks:

RUCKUS SmartZone (ST-GA) Guest Access Guide, 7.0.0
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3.

Complete the following fields:

Guest Name: Enter guest name.

Guest WLAN: Select the guest WLAN from the drop down menu.

Number of Passes: Enter number of guest passes to be generated.

Pass Valid For: Set the validity for the guest pass by entering the number and selecting the period from the drop-down menu. For

example, if you want the guest pass to be valid for seven days, type 7 in the first box, and then select Days in the second box.

Under Advance Options tab complete the following fields:

Pass Generation: The Auto Generate option is ON by default, and it generates the guest pass key automatically. If you want to

generate the guest pass key manually, turn it OFF and enter the guest pass key in the Pass Value field.

NOTE
If Number of Passes is more than one, the Pass Generation field will be disabled.

Pass Effective Since: Set the guest pass validity period by selecting one of the following options:

Effective from the creation time: This type of guest pass is valid from the time it is created to the specified expiration time, even
if it is not being used by any end user.

Effective from first use: This type of guest pass is valid from the time the user uses it to authenticate with the controller until the
specified expiration time. An additional parameter (Guest Pass will expire in X days) can be configured to specify when an
unused guest pass will expire regardless of use. The default is 7 days.

Expire new guest pass if not used within [ ] days: If you want this guest pass to expire if it is unused after you generated it, type
the number of days in the box (maximum value is 365 days).

Max Devices Allowed: Set the number of users that can share this guest pass by selecting one of the following options:

Limited to [ ]: If you want a limited number of users to share this guest pass, click this option, and then type the number in the
box.

Unlimited: Enable this option If you want to share the guest pass with unlimited users.

Session Duration: This option is available only if the Unlimited option is enabled and the Session Duration option is ON. Enter
the session time in the Require guest re-login after [ ] field. The session time can be set in minutes, hours, days, and weeks. This
option controls the session time for users. When the session time expires, the user must log in again. This option is enabled by
default. To disable it, turn it OFF. When this feature is disabled, connected users will not be required to log in again until the
guest pass expires.

Remarks: This is optional. Use this option to add any notes about the guest pass.

Click Generate.

The page refreshes, the guest pass generated appears in the Admin Generated Guest Passes table, along with other guest passes that

exist on the controller.
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5. Toenable the guest pass for a user, select the guest pass from the Admin Generated Guest Passes table and click Enable icon. To disable
the guest pass for a particular user, select the guest pass from the Admin Generated Guest Passes table and click Disable icon.

FIGURE 15 Admin Generated Guest Passes - Enable or Disable

GuestPass  Guest Pass Template

Self-Service Generated Guest Passes

- n System

More Y FitterOFf  £# | search table Q <%

CORGANIZATION

No data 1

ate a guest pass, click Generate Guest Pass. To import guest pass, click Import Guest Pass.

& Ge:

teGuestPass L. Import Guest Pass
Guest Instruction HTML Template: | defulttml |

& Print Selected oo ExportSelected [ Email | [ sMS  Delete | Enable More Y Fitteroff | £ | search table Q 8

GuestName a

test System 9nFd2sbb test 2023/02/14 14:12:34 N/A [AISH-6.1.1-GUEST] of [Al...  admin

To find the guest passes, click the W Fitter o El icon and apply filters or you can use the Search Table field.

To view the guest pass information, click on the guest pass from the Admin Generated Guest Passes table. A guest pass has the following
information.

e  Summary: Displays a summary of information about the user and credentials.
e  Admin Activities: Displays information about the administrator activities.
e  Event: Displays information about events associated with the user.

. T FEilber O El . . -'.-;ﬂ . . .
Click the icon to apply filters. Click the icon to export all the data into a CSV file.

4

To export the guest passes data into a CSV file, select the guest passes and click = icon.

NOTE
You can generate maximum 120000 guest passes for SZ100, and 40000 guest passes for vSZ-E.

NOTE
You can generate maximum 40000 guest passes for SZ300, and 1000000 guest passes for vSZ-H.

NOTE
The controller GUI allows you to view only 1000 guest passes. To view the guest pass list above 1000 passes, you must use the public
API's.

Step 4: Send Guest Passes to Guest Users
Deliver the guest passes to guest users as per the delivery options that you choose.

The page that appears after you generate a guest pass contains options for delivering the guest pass to guest users (see the following image).
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FIGURE 16 Options for delivering guest passes to guest users

Here are the generated guest passes

& Print Selected | = Export Selected | Email | O sMs ||| Delete
Guest Name & Manage By Key Remarks
Sam System Wh305HEg One day pass
Sen System sajeikCy HiA

test2 System DHp2uBD3 NiA

[ Disable

More ¥ Y Filter Off | &¥

Generated

2017703708 17:41:30

2017703708 18:45:26

HTI01 /18 14:19:18

Expiration Date

2017703709 17:41:30

HiA

ATI0N /19 14:19:18

WLAH

[SZ-300-GUEST] of [TEST-JI_..
[SZ-300-GUEST] of [TEST-JI...

[SZ-300-GUEST] of [TEST-JI...

3 total records 1

Generating Guest Passes from an Imported CSV

You can also manually define the guest passes that you want to generate in a comma-separated value (CSV) file (a sample of which is available for

download from the Guest Pass page).

Follow these steps to generate guest passes from an imported CSV file.

1. On the menu, click Security > Access Control > Guest > Guest Pass to display the Guest Pass window.

24
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1 Import Guest Pass

L ..
2.  From the Admin Generated Guest Passes tab, click

FIGURE 17 Import Guest Pass

Guests
Guest Passes

icon to display the Import Guest Pass dialog box.

Import Guest Pass

Guest List CSV File:

Todownload a sample guest pass, click here

Common Guest Pass Settings

Browse

Guest WLAM: | [AISH-6.1.1-GUEST] of [AISH-§.1.1.0.611]

Paszs Valid For: | 1

Advanced Options

Pass Effective Since: é" Effective from the creation time

: | Effective from first use

Max Devices Allowed: é‘ Limitedto | 1
() Unlimited

Cancel

3. Look for the following text under Browse:
To download a sample guest pass, click here.
4. Click here link to download the sample CSV file.

5. Open the CSV file with Microsoft Excel or a similar application.
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6. Inthe CSV file, fill out the following columns:
° #Guest Name (Must): Assign a user name to the guest pass user.
e  Remarks (Optional): Add some notes or comments about this guest pass.

o  Key: Enter a guest pass key or leave it blank so the controller can generate the key automatically.

FIGURE 18 The sample CSV file when opened in Excel

A6 - I
A B C

1 |HGuest Mame [Must) Remarks Key (Empty Implies random key)
2 |Batch-Guest-1 Batch peneration  AAAARADLA
3 Batch-Guact-2 Batcn genaration
4 Batch-Guest-3
3
& | |
[
2
9
10
11
12
13
14

7. Save the CSV file.
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8. Open Import Guest Pass dialog box and complete the following fields in the Common Guest Pass Settings tab:
o  Guest WLAN: Select the guest WLAN from the drop down list.

e  Pass Valid For: Enter the pass validity. The validity period can be set in hours, days, and weeks. For example, if you want the guest
pass to be valid for seven days, type 7 in the first box, and then select Days in the second box.
e Inthe Advanced Options tab complete the following fields:
- Pass Effective Since: Set the guest pass validity period by selecting one of the following options:
> Effective from the creation time: This type of guest pass is valid from the time it is first created to the specified expiration
time, even if it is not being used by any end user.
> Effective from first use: This type of guest pass is valid from the time the user uses it to authenticate with the controller
until the specified expiration time. An additional parameter (Guest Pass will expire in X days) can be configured to specify
when an unused guest pass will expire regardless of use. The default is 7 days.
y Expire guest pass if not used within [ ] days: If you want this guest pass to expire if it is unused after you generated it, type
the number of days in the box (maximum value is 365 days).
- Max Devices Allowed: Set the number of users that can share this guest pass.
> Limited to [ ]: If you want a limited number of users to share this guest pass, click this option, and then type the number in
the box.
> Unlimited: Enable this option if you want to share the guest pass with unlimited users.
> Session Duration: This option is available only if the Unlimited option is enabled. Enter the session time in the Required
guest to log on again after field. The session time can be set in minutes, hours, days, and weeks. This option controls the
session time for users. When the session time expires, the user must log in again. This option is enabled by default. To
disable it, turn it OFF. When this feature is disabled, connected users will not be required to log in again until the guest pass

expires.

9. In Guest List CSV File (at the top of the page), click Browse, and then select the CSV file you edited earlier.

The page refreshes, and the number of guest passes that the controller has identified in the CSV file appears below the Browse button.
10. Click Import.

The page refreshes, and then the guest pass you generated appears in a table, along with other guest passes that exist on the controller.

To send the guest pass to guest users, refer to Step 4: Send Guest Passes to Guest Users on page 23.
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Guest Pass Template

Creating a Guest Instruction HTML Template

A guest pass template is a HTML file which contains variables for the information that guest users need to connect to the controller hotspots (for
example, guest name, key, and WLAN name), and actual instructions for connecting to the guest WLAN.

A default printout template exists in the controller. If you want to create your own printout template, follow these steps.

1. On the menu, click Security > Access Control > Guest Pass Template to display the Guest Pass Template window.

FIGURE 19 Guest Pass Template

E | Monitor 5 Network U security & Services & Administration s u © Ruckus Analytics S¢ G Guest Guest Pass Template

GuestPass  GuestPass Template

£ Viewexisting guest templates and basic nformation about them. To view detailed information about a specific guest template, click the guest template name.

Guest Instruction HTML Templates

[ 0 EEZE

X, upload search table Q %

Name o

ORGANIZATION

defaulthtml System

Guest Instruction SMS Templates

Mo pua

X, upload search table Q o%n
Name &

default.txt System

2. Inthe Guest Instruction HTML Template tab, click default.html, which is the default guest pass printout template.
The content of the default guest pass printout template appears in the Name: default.html
3. Click Download icon below the template preview area to download a copy of the template to your computer.

4. Using an HTML editor, create a new HTML file.
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5. Add content to the file.

Typically, a printout template contains instructions for connecting to the controller hotspot. See the following image for the content of the
default printout template.

FIGURE 20 Content of the default printout template

Connecting as a Guest
to the Corporate Wireless Network
Greetings, {GP_GUEST_NAME}

You have been granted access to the company wireless network, which you can uss to access both the
World Wide Web and Internet, and to check your persenal email.

Wour guest pass key is: {GP_GUEST_KEY}
This guest pass is valid until {GP_VALID TIME}

Connact your wireless-ready PC to the following network(s): {GP_GUEST_WLANY}. as detailed in the
instructions printed belowr.

Before you start, please review the following reguiremeants.

6. Insert the following variables into the content of your template:

o  {GP_GUEST_NAME]}: This is the guest pass user name.

o  {GP_GUEST_KEY}: This is the guest pass key.

e  {GP_VALID_TIME}: This is the expiration date and time of the guest pass.

o  {GP_GUEST_WLAN}: This is the WLAN with which the guest user can associate using the guest name and guest key.
7. Save thefile.

8. Open the Guest Instruction HTML Template tab, click Upload icon to display the Upload a Template File tab.

FIGURE 21 Upload a Template File

Guest Instruction HTML Templates

X Upload search table Q cu

Name &

default.html System

Upload a Template File
Template Names

Template File: Browse

9. Complete the following fields:
o Template Name: Type a name for the template that you are uploading.
e Template File: Click Browse, and select the template file you created.

10. Click Upload.

An information message box appears and informs you that the template file has been uploaded successfully.
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11.

Click OK.

The template file you uploaded now appears in the list of templates.

FIGURE 22 The Upload a Template File form

Guest Instruction HTML Templates
£ i Q [ e
Hame Manage By & ‘ﬁ'
default.html System

a System

Creating a Guest Instruction SMS Template

A guest SMS template is a text file which contains variables for the information that guest users need to connect to the controller hotspots (for
example, guest name, key, and WLAN name), and actual instructions for connecting to the guest WLAN.

A default printout template exists in the controller. If you want to create your own printout template, follow these steps.

1.
2.

30

On the menu, click Security > Acesss Control > Guest Pass Template to display the Guest Pass Template window.

In the Guest Instruction SMS Template section, click default. txt, which is the default guest pass printout template.

The content of the default guest pass printout template appears in the Name: default.txt.

Click Download icon below the template preview area to download a copy of the template to your computer.

Using an HTML editor, create a new text file.

Add content to the file.

Typically, a printout template contains instructions for connecting to the controller hotspot. See the following image for the content of the

default printout template.

FIGURE 23 Content of the default printout template

Connecting as a Guest
to the Corporate Wireless Network

Greetings, {GP_GUEST_NAME}

You have been granted access to the company wireless netwark, which you can use to access both the
World Wide Web and Internat, and to check your personal email.

Your guest pass key is: {GP_GUEST_KEY}
This guest pass is valid until {GP_VALID TIME}

Connect your wireless-ready PC to the following network({s): {GP_GUEST_WLANY}, as detailed in the
instructions printed below.

Before you start, please review the following requirements.
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6. Insert the following variables into the content of your template:

o  {GP_GUEST_NAME}: This is the guest pass user name.

o  {GP_GUEST_KEY}: This is the guest pass key.

e  {GP_VALID_TIME}: This is the expiration date and time of the guest pass.

o  {GP_GUEST_WLAN}: This is the WLAN with which the guest user can associate using the guest name and guest key.
7. Save the file.
8. In the Guest Instruction SMS Template tab, click Upload icon to display the Upload a Template File tab.

FIGURE 24 Upload a Template File

Guest Instruction SMS Templates

2 upload search table Q cu
defaulttxt System
1records 1
Upload a Template File
Template Name:

Template File: Browse

9. Complete the following fields:
o Template Name: Type a name for the template that you are uploading.
e  Template File: Click Browse, and select the template file you created.
10. Click Upload.
An information message box appears and informs you that the template file has been uploaded successfully.

11. Click OK.

The template file you uploaded now appears in the list of templates.

FIGURE 25 The Upload a Template File form

Guest Instruction SMS Templates

X Upload | Q | & Refresh

Name & Manage By

OETaull. txt SYSLEM
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Working with Hotspots and Portals
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e  Working with Hotspot 2.0 Services.... .
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e  Creating Network Segmentation Profile 0n the VSZ CONtrOllEr.........c.uiiiuiiiiiiiiiiieceecteetee ettt ve e e 78
e  Ethernet Profiles

Creating a Guest Access Portal

Using the controller's Guest Access features, you can provide visitors to your organization limited access to a guest WLAN with configurable guest
policies. The following sections describe how to configure guest WLANs and access policies that control guest use of your network.

Each guest WLAN must be associated with a Guest Access service portal, which defines the behavior of the guest WLAN interface. Follow these
steps to create a guest access service.

1.  Onthe menu, click Services > Hotspots & Portals > Guest Access to display the Guest Access window.

FIGURE 26 Guest Access

GuestAccess  Holspot (WISPr)  Hotspot2.0  WebAuth  UABlackist  Portal Detection & Suppression  WeChat

z< al z#
ame oescrpton
-
g AISH GUEST PORTAL N/A
g
o
= INT N/A
§
g
g

2. Inthe Organization tab, select the zone for which you want to create the guest access portal.
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3. Click Create, to display the Create Guest Access Portal dialog box.

FIGURE 27 Creating a Guest Access Portal

Create Guest Access Portal

General Options
Redirection
Guest Access

User Session
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4. Complete the following fields:

a. General Options

FIGURE 28 Create Guest Access Portal - General Options

Create Guest Access Portal

General Options

Portal Name:

Portal Description:

Language: | English

o  Portal Name: Type a name for the guest access service portal that you are creating.
e  Portal Description: Type a short description of the guest access service portal.
e Language: Select the display language to use for the buttons on the guest access logon page.

b. Redirection: Select where to redirect the user after successfully completing authentication.

FIGURE 29 Create Guest Access Portal - Redirection

Create Guest Access Portal

General Options

Redirection

Start Page: After user is authenticated,

(®) Redirect to the URL that user intends to visit. () Redirect to the following URL:

e  Redirect to the URL that the user intends to visit: Allows the guest user to continue to their destination without redirection.

e  Redirect to the following URL: Redirects to the specified domain name or IP address. When the Guest Access Portal's Guest
Authentication is "Always Accept" and the Guest Access does nott enable the "Terms and Conditions", the client will be
redirected to this page for 3 seconds and then go to the start URL or the original URL the browser opens". After 3 seconds
redirect to the Start Page.
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FIGURE 30 Redirecting Page

- 10.206.82.37/welcome.htm| x IR = O x

e 2R} (D 10.206.82.37/welcome. html aee i Yoin @ » =

Please wait and it is redirecting to the portal page

c.  Guest Access
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FIGURE 31 Create Guest Access Portal - Guest Access

Create Guest Access Portal

Redirection o

Guest Access

Self-registration:
Guest Pass SMTP Server:

Guest Pass SM5 Gateway: | Disabled

Terms and Conditions: (AN )

By accepting this agreement and accessing the wireless network, you acknowledge that you are of legal
age, vou have read and understood, and agree to be bound by this agreement.

(") The wireless network service is provided by the property owners and is completely at their discretion,
Your access to the network may be blocked, suspended, or terminated at any time for any reason,

(™) You agree not to use the wireless network for any purpose that is unlawful or otherwise prohibited
and you are fully responsible for your use.

(") The wireless network is provided "as is” without warranties of any kind, either expressed or implied.

This wireless network is powered by Ruckus CommScope.

Web Portal Logo: Browse

Web Portal Title: | Welcome to the Guest Access login page.

Pass Valid For: | 1

Pass Effective Since: () Effective from the creation time

(®) Effective from first use

Expire new guest pass if not used within: | 7 days
Max Devices Allowed: | | Limitedto 1
(®) Unlimited
Session Duration: Required guest to log on _
el = 1 rs
again after:

Motification Method: | E-Mail |

o  Self Registration: Enable the option to register for the guest pass.
e  Guest Pass SMTP Server: This feature is only available if the Self-registration feature is enabled. Enable the option to receive the

copy of guest pass by email.

e  Guest Pass SMS Gateway: You can deliver the guest pass to the user using Short Message Service (SMS). But first you need to
configure an SMS server. If you previously configured an SMS server, you can select it here or you can select Disable.

e Terms and Conditions: To require users to read and accept your terms and conditions prior to use, Show Terms and Conditions
check box. The box below, Terms and Conditions which contains the default Terms of Use text, becomes editable. Edit the text or
leave it unchanged to use the default text.
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d.

Web Portal Logo: By default, the guest hotspot logon page displays the RUCKUS logo. To use your own logo, click the Browse
button, select your logo Web Portal Logo (recommended size is 138 x 40 pixels, maximum file size is 20KB), and then click Open.

Web Portal Title: Type your own guest hotspot welcome text or accept the default welcome text (Welcome to the Guest Access
login page).

Pass Valid For: This feature is only available if the Self-registration feature is enabled. Set the guest pass validity. The validity
time can be set in hours, days, and weeks.

Pass Effective Since: This feature is only available if the Self-registration feature is enabled. Set the guest pass validity period by
selecting one of the following options:

-  Effective from the creation time: This type of guest pass is valid from the time it is first created to the specified expiration
time, even if it is not being used by any end user.

- Effective from first use: This type of guest pass is valid from the time the user uses it to authenticate with the controller
until the specified expiration time. An additional parameter (Guest Pass will expire in X days) can be configured to specify
when an unused guest pass will expire regardless of use. The default is 7 days.

- Expire guest pass if not used within [ ] days: If you want this guest pass to expire if it is unused after you generated it, type
the number of days in the box (maximum value is 365 days).

Max Devices Allowed: This feature is only available if the Self-registration feature is enabled. Set the number of users that can
share this guest pass.

- Limited to [ ]: If you want a limited number of users to share this guest pass, click this option, and then type the number in
the box.

- Unlimited: If you want an unlimited number of users to share this guest pass, click this option.

- Session Duration: This option is available only if the Unlimited option is enabled. Enter the session time in the Required
guest to log on again after field. The session time can be set in minutes, hours, days, and weeks. This option controls the
session time for devices. When the session time expires, the user must log in again. This option is enabled by default. To
disable it, turn it OFF. When this feature is disabled, connected users will not be required to log in again until the guest pass
expires.

Notification Method: This feature is only available if the Self-registration feature is enabled. Select how the guest pass must be
notified to the user. For example: E-Mail, Mobile, and Mobile and E-mail.

User Session
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FIGURE 32 Create Guest Access Portal - User Session

Create Guest Access Portal

General Options
Redirection
Guest Access

User Session

Session Timeout: | 1440 Minutes (2-14400)

Grace Period: = 60 Minutes (1-14399)

e  Session Timeout: Specify a time limit after which users will be disconnected and required to log on again.

o  Grace Period: Set the time period during which clients will not need to re-authenticate after getting disconnected from the
hotspot. Enter a number (in minutes) between 1 and 14399.

5.  Click OK.

NOTE
You can also edit, clone and delete a guest access portal by selecting the options Configure, Clone and Delete respectively, from the
Guest Access window.

Working with Hotspot (WISPr) Services

A hotspot is a venue or area that provides Internet access to devices with wireless networking capability such as notebooks and smart phones.

Hotspots are commonly available in public venues such as hotels, airports, coffee shops and shopping malls. Configure a traditional (WISPr 1.0)
hotspot service to provide public access to users via its WLANSs. In addition to the controller and its managed APs, you will need the following to
deploy a hotspot:

Captive Portal: A special web page, typically a login page, to which users that have associated with your hotspot will be redirected for
authentication purposes. Users will need to enter a valid user name and password before they are allowed access to the Internet through the
hotspot.

RADIUS Server: A Remote Authentication Dial-In User Service (RADIUS) server through which users can authenticate.

For installation and configuration instructions for the captive portal and RADIUS server software, refer to the documentation that was provided with
them. After completing the steps below, you will need to edit the WLAN(s) for which you want to enable Hotspot service. The controller supports up
to 32 WISPr hotspot service entries, each of which can be assigned to multiple WLANSs.
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Creating a Hotspot (WISPr) Portal

To create a hotspot service, you must define the required basic settings.

SZ supports only one grace period, session timeout, UTP, VLAN and all UE session related configuration. These configurations for the first WLAN do
not work when the UE joins the second WLAN. The configuration works only when the UE roams within the cluster node. The configurations do not
work when the client roams from one zone to another zone or from one cluster to another cluster.

Before creating a hotspot, you need to create a user defined interface.

1. Go to Services > Hotspots & Portals > Hotspot (WISPr) to display the Hotspot (WISPr) window.

FIGURE 33 Hotspot (WISPr)

# |#* Monitor i Network 0 security 4 services & Administration * searchmenu © Ruckus Analytics Services > Hotspots &Portals > Hotspot (WISPr)

GuestAccess  Hotspot (WISPr)  Hotspot20  WebAuth  UABlacklist  Portal Detection & Suppression  WeChat

Name &

DHCP NAT PORTAL

NT

ORGANIZATION
S

WISPr

MOU 1BUN

2. Inthe Organization tab, select the zone for which you want to create the Hotspot (WISPr) portal.
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3. Click Create to display the Create Hotspot Portal dialog box.

FIGURE 34 Creating a Hotspot (WISPr) Portal

Working with Hotspots and Portals
Working with Hotspot (WISPr) Services

Create Hotspot Portal

General Options

Redirection

Portal Settings

User Session

Location Information

Walled Garden / Traffic Class Profile

Advanced Options

Cancel
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4. Complete the following fields:

a. General Options

FIGURE 35 Create Hotspot Portal - General Options

Create Hotspot Portal

General Options

Portal Name:

Portal Description:

e  Portal Name: Type a name for the hotspot portal that you are creating.
e  Portal Description: Type a short description of the hotspot portal.

b. Redirection

FIGURE 36 Create Hotspot Portal

Create Hotspot Portal

General Options

Redirection
Smart Client Support: (@) None () Enable () Only Smart Client Allowed
Logon URL: | ) Internal | ) External
Redirect unauthenticated user: Primary:
Secondary:

Redirected MAC Format: | AA:BB:CC:DD:EE:FF

Start Page: After user is authenticated,

HTTPS Redirect: The AP will try to redirect HTTPS requests to the hotspot portal

( ) Redirect to the URL that user intends to isit. ( ) Redirect to the following URL:

e  Smart Client Support: Select one of the following options:

- None: Disables Smart Client Support on the hotspot service.
- Enable: Enables Smart Client Support.

- Only Smart Client Allowed: Allows only Smart Clients to connect to the hotspot service.

e Logon URL: Select one of the following options:

- Internal: Indicates the internal URL of the subscriber portal (where hotspot users can log in to the service). If you select

Internal, you have to manually configure the following Portal Settings.

42
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FIGURE 37 Create Hotspot Portal: Logon URL-Internal

Create Hotspot Portal

General Options

Redirection

Smart Client Support: ( | None | | Enable | | Only Smart Client Allowed

Logon URL: | ) Internal ) External

Redirected MAC Format: | AA:BB:CC:DD:EE:FF

Start Page: After user is authenticated,
( | Redirect to the URL that user intends to visit. | | Redirect to the following URL:

HTTPS Redirect: The AP will try to redirect HTTPS requests to the hotspot portal

Portal Settings

Portal Language: | English

Portal Title:
Portal Logo: Browse
Portal Terms & Conditions:

fully respensible for your use. -
() The wireless network is provided "as is” without warranties of any kind, either expressed or implied.

This wireless network is powered by Ruckus CommScope.

)

>

>

Portal Language: Select the required language from the drop down list.

Portal Title: Enter the portal title.

Portal Logo: Click Browse to upload the portal logo.

Portal Terms & Conditions: Switch ON to accept the portal terms and conditions.

- External: Indicates the external URL of the subscriber portal.

Selecting External provides an option to reroute an unauthorized user to a primary location. You can set the primary
location in Redirect unauthenticated user. If an unauthorized user is rerouted, the AP redirects the UE to a backup portal.

The AP subscriber portal supports ZD-style API to login and logout. A customer can use AP IP address to submit the login or
logout request.

e  Redirect unauthenticated user: APs can perform WISPr redirection. Native WISPr support is available on SZ-managed APs even if
access to SZ is not available. It supports external portal redirection with survivability when APs cannot reach the centralized SZ.
It also supports backup portal redirection if primary portal is down. The WISPr authentication load can be distributed to AP or
use an AP as a WISPr authentication backup.

WISPr redirection and survivability is supported only on Ruckus 11AC Wave 1 and later APs. Only ZD-style external WISPr is

supported. No NBI is supported for backup.

- Primary: Redirects an unauthenticated user to a specified URL for authentication.
- Secondary: Redirects an unauthenticated user to the backup external portal if the primary URL is down. The AP periodically
accesses the primary portal URL to detect and check the availability of the primary URL.

NOTE
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The AP uses the secondary portal when the AP cannot access the primary portal.

e Redirected MAC Format: Enter the format of the redirection MAC address.
e  Start Page: Select one of the following options:

- Redirect to the URL that the user intends to visit: Redirects users to the page that they want to visit.
- Redirect to the following URL: Sets a different page where users will be redirected (for example, your company website).
Enter a domain name or an IP address to be redirected.

e  HTTPS Redirect: Switch ON HTTPS Redirect, if you want the AP to redirect HTTPS requests to the hotspot portal. HTTPS requests
are dropped if this option is disabled.

c.  User Session

FIGURE 38 Create Hotspot Portal - User Session

Create Hotspot Portal

General Options
Redirection

User Session

Session Timeout: | 1440 Minutes (2-14400)

Grace Period: | 60 Minutes (1-14393)

e  Session Timeout: Sets a time limit (in minutes) after which users will be disconnected from the hotspot service and required to
log in again.

e  Grace Period: Sets the time period (in minutes) during which disconnected users are allowed access to the hotspot service
without logging in again.

d. Location Information
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FIGURE 39 Create Hotspot Portal - Location Information

Create Hotspot Portal

General Options
Redirection
User Session

Location Information

Location ID: (example: isocc=us,cc=1,ac=408, network=ACMEWISP_NewarkAirport)

Location Name: (example: ACMEWISP,Gate_14_Terminal_C_of Mewark_Airport)

e Location ID: enter the ISO and ITU country and area code that the AP includes in accounting and authentication requests. The
code includes the following requirements:

- isocc (ISO-country-code): The ISO country code that the AP includes in RADIUS authentication and accounting requests.
- cc (country-code): The ITU country code that the AP includes in RADIUS authentication and accounting requests.
- ac (area-code): The ITU area code that the AP includes in RADIUS authentication and accounting requests.
- network: Name of the network.
The following example illustrates a proper location ID entry: isocc=us,cc=1,ac=408,network=Ruckus
e  Location Name: Enter the name of the location of the hotspot service.

e. Walled Garden/Traffic Class Profile
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FIGURE 40 Create Hotspot Portal - Walled Garden/Traffic Class Profile

Create Hotspot Portal

General Options

Redirection

User Session

Location Information

Walled Garden [ Traffic Class Profile

| ) Walled Walled Garden Entry =+ Add Import CSWV » ¥ Cancel
Garden

Walled Garden Entry a

No data 1

Unauthenticated users are allowed to access the following destinations.

Format:

with special regular expression like
- " aMazon.com

*.com

() Traffic Class Profile

e  Walled Garden

- Walled Garden Entry Add: Enter an IP address or a domain name and click Add to add a Walled Garden Entry.
- Walled Garden Entry Import:

FIGURE 41 Walled Garden Entry - Import

Walled Garden [ Traffic Class Profile

(®) walled Walled Garden Entry + Add ’ Import CSV| v | % Cancel
Gard
Araen | == Download Sample CSV |

Walled Garden Entry &

Mo data 1

»  Click down facing arrow at the edge of Import CSV icon.
> Click Download Sample CSV option to download the sample file.
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»  Add the user information in the download sample CSV excel file.
> Click Import CSV icon and import the sample CSV excel file created by you.

e  Traffic Class Profile: Select a traffic class profile from the drop down list or click * icon to create a traffic class profile. Refer to
Creating a Traffic Class Profile for more information.

Advanced Options

NOTE

This option is available only if the Traffic Class Profile option is enabled .

FIGURE 42 Create Hotspot Portal - Advanced Options

Working with Hotspots and Portals
Working with Hotspot (WISPr) Services

Create Hotspot Portal

uUSEl ELaiun
Location Information
Walled Garden [ Traffic Class Profile

() walled
Garden

(@) Traffic Class Profile | Select Traffic Class Profile

Advanced Options

L _J Use Token Redirect URL
Signature Signing Key:
L _J Enable Internal Node

Internal Node:

o  Use Token Redirect URL: Switch ON Use Token Redirect URL and enter a signature signing key.

e  Enable Internal Node: Switch ON Enable Internal Node and enter the internal node.

NOTE

If an Internal node is enabled, then only one IP is used and the IP domain name and IP ranges are not supported.
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5.  Click OK.

NOTE
If Traffic Class Profile or Use Token Redirect URL is enabled, Smart Client Support is set to None.

NOTE
You can also edit, clone, and delete a Hotspot (WISPr) portal by selecting the options Configure, Clone, and Delete respectively, from the
Hotspot (WISPr) window.

Working with Hotspot 2.0 Services

You must be aware of Hotspot 2.0 - a Wi-Fi Alliance specification that allows for automated roaming between service provider access points when
both the client and access gateway support the newer protocol.

Hotspot 2.0 (also known as Passpoint™, the trademark name of the Wi-Fi Alliance certification) aims to improve the experience of mobile users
when selecting and joining a Wi-Fi hotspot by providing information to the station prior to association.

This information can then be used by the client to automatically select an appropriate network based on the services provided and the conditions
under which the user can access them. In this way, rather than being presented with a list of largely meaningless SSIDs to choose from, the Hotspot
2.0 client can automatically select and authenticate to an SSID based on the client's configuration and services offered, or allow the user to
manually select an SSID for which the user has login credentials.

The controller's Hotspot 2.0 implementation complies with the IEEE 802.11u standard and the Wi-Fi Alliance Hotspot 2.0 Technical Specification.

See the Hotspot 2.0 Reference Guide for SmartZone for information on configuring Hotspot 2.0 services, including:
e  Working with Hotspot 2.0 operator profiles
e  Working with Hotspot 2.0 identity providers

e  Creating a Hotspot 2.0 online signup portal

Creating a Hotspot 2.0 WLAN Profile

You can assign and Hotspot 2.0 service to a Hotspot 2.0 WLAN, for which you must create a Hotspot 2.0 WLAN profile.

Follow these steps to create a Hotspot 2.0 WLAN profile.
1.  Onthe menu, click Services > Hotspots & Portals > Hotspot 2.0 to display the Hotspot 2.0 window.

FIGURE 43 Hotspot 2.0

* | Monitor &% Network 0 security & Services & Administration * searchmenu €© All New Analytics Services > Hotspots&Portals > Hotspot 2.0

GuestAccess  Hotspot(WISPr)  Hotspot20  WebAuth  UABlacklist  Portal Detection & Suppression  WeChat

£ ¢ WLAN Profile
Y create search table Q o

Name & Descriptior Last Modified On Last Modified By

ORGANIZATION

AISHZD AP

MOu1PUN
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2. Inthe Organization tab, select the zone for which you want to create the Hotspot 2.0 WLAN portal.

* Creste
3. Inthe WLAN Profile tab, click " icon to display the Create Hotspot 2.0 WLAN Profile dialog box.

FIGURE 44 Creating a Hotspot 2.0 WLAN Profile

Create Hotspot 2.0 WLAN Profile

Name:

Description:

Operator: | No data available | +

Identity Providers:  Identity Provider | 1o data available | = Add 3 Cancel 3 Create

You can configure single 5510 and Onboarding 551D when you add anidentity provider that has Online Signup & Provisioning enabled
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Complete the following fields:

Name: Enter a name for this WLAN profile. This name identifies the WLAN profile when assigning an HS2.0 service to a H52.0 WLAN.
Description: Enter a description for the WLAN profile.

Operator: Select the operator profile. This name identifies the service operator when assigning an HS2.0 service to a H52.0 WLAN.

You can also click Create to create a Hotspot 2.0 WiFi operator. See Creating a Hotspot 2.0 WiFi Operator Profile on page 52 for
more information.

Identity Provider: Choose one or more identity providers. Choose the identity provider. You can configure an OSU SSID when you add
an Identity Provider which enables OSU and provisioning. Since there may be more than one identity provider per Hotspot 2.0
profiles having its own authentication profile, the No Match and Unspecified mapping could be duplicated. To avoid duplication, the
default identity provider is taken as the correct configuration for No Match and Unspecified mapping. OSUSSID can be OSEN or OPEN
[Guest].

You can also click Create to create a Hotspot 2.0 identity provider. See Creating a Hotspot 2.0 Identity Provider on page 55 for more
information.

Single SSID: Provides capability to support both OSU network and production network on the same WLAN. This option is available
only when the Identity Provider has enabled Online Signup & Provisioning.

Onboarding SSID: Allows the devices to connect to a Wi-Fi network automatically, where the service providers engage in roaming
partnership to provide seamless access to Wi-Fi networks. Onboarding SSID is an optional configuration when Single SSID is enabled
and a mandatory configuration when Single SSID is not enabled. This option is available only when the Identity Provider has enabled
Online Signup & Provisioning.

Under Advanced Options, Complete the following fields:
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FIGURE 45 Create Hotspot 2.0 WLAN Profile - Advanced Options

Create Hotspot 2.0 WLAN Profile

Advanced Options

Internet Option: Specified with connectivity to the Internet

Access Network Type: | Private |

IPvd Address: | Single NATed private address |

1Pw6 Address: | Not Available |

Connection Capabilities: Protocol Name Protocol Number Port Number Status

ICMP 1 0 Closed
FTP 6 20 Closed
S5H G 22 Open
HTTP 6 80 Open
Used by TLS VPN 6 443 Closed
Used by PPTP VPNs 6 1723 Closed
Volp 6 5060 Closed
VolP 17 5060 Closed
Used by IKEVZ(IPsec VPN) 17 500 Closed
IPsec VPN 17 4500 Closed
ESP 50 0 Closed
Custom Connection ~_Protocol Name Protocol Number Port Number Status
Capabilities: = Add 3 Cancel
Protocol Hame & Protocol Numbe Port Number Stat

- Internet Options: Specify if this H52.0 network provides connectivity to the Internet.

- Access Network Type: Access network type (private, free public, chargeable public, etc.), as defined in IEEE802.11u.

- IPv4 Address: Select IPv4 address type availability information, as defined in IEEE802.11u

- IPv6 Address: Select IPv6 address type availability information, as defined in IEEE802.11u

- Connection Capabilities: Provides information on the connection status within the hotspot of the most commonly used
communications protocols and ports.

Provide the Protocol Name, Protocol Number, Port Number and Status to Add a new connection.

- Custom Connection Capabilities: Allows addition of custom connection capability rules. Up to 21 custom rules can be created.

Provide the Protocol Name, Protocol Number, Port Number and Status to Add a new connection.

5. Click OK.

NOTE
You can also edit, clone and delete a Hotspot 2.0 WLAN profile by selecting the options Configure, Clone and Delete respectively, from
the WLAN Profile tab in the Hotspot 2.0 window.
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Creating a Hotspot 2.0 WiFi Operator Profile

An operator profile defines all the properties pertaining to an operator while a service profile defines the properties related to a service provider. If
a WLAN is configured to provide Hotspot 2.0 service, it must be linked exactly like a Hotspot 2.0 operator profile.

1.  On the menu, click Services > Hotspots & Portals > Hotspot 2.0 to display the Hotspot 2.0 window.

FIGURE 46 Hotspot 2.0: Wi-Fi Operator

© AlNew Analytics

g
2

2. Inthe Organization tab, select the zone for which you want to create the Hotspot 2.0 portal.
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te
3. From Wi-Fi Operator tab, click : icon to display the Create Hotspot 2.0 Wi-Fi Operator Profile dialog box.

FIGURE 47 Creating a hotspot 2.0 Wi-Fi operator profile

Create Hotspot 2.0 Wi-Fi Operator Profile

Name:

Description:

Domain Names: © Domain Name

Domain Name a
Signup Security: Support Anonymous Authentication (OSEN)

Language MName
Englizh

Language Mame

Friendly Hames:

Advice of Charge: =+ Create

m
=
=
i
1
=]

Language lean

Operator lcon:
English Browse Clear

Language & lcon

Terms Conditions: File Mame:

Time Stamp:

< Add ¥ Cancel

= Add 3 Cancel

4 Add 3 Cancel

File Name
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4. Complete the following fields:

e Name: Enter a name for this Wi-Fi operator profile.

e  Description: Enter a description for the venue profile.

e Domain Names: HS2.0 operator's domain name is a mandatory field, which specifies the operator’s domain name. Hotspot 2.0 AP
broadcasts the domain name to indicate the home Wi-Fi providers.

e  Signup Security: This is an optional field and is disabled by default. Enabling would mean that operator supports secure onboarding
(OSEN).

o  Certificate: Select the certificate for the operator - AAA. This can be the same certificate as the one used with OSU service.

o  Friendly Names: HS2.0 operator's friendly name is a mandatory field. Operator's friendly name is displayed on mobile client's screen.
It is also used for operator verification during secure onboarding (OSEN). Select the display language from the drop down list.

e  Advice of Charge: The advice of charge may be issued for the first time or every time a user connects to a Wi-Fi service. The advice of
charge must be acknowledged before accessing the network. Click Create to display the Create Advice of Charge dialog box.
Complete the following fields:

- Type: Select one of the following plan type.
y Time-Based
y Data-Volume-Based
»  Time-and-Data-Volume-Based
» Unlimited
- NAI Realm: Select one of the following encoding option.
» Encoding
> Name
- Plan Information: The plan information is provided on a per NAl-realm basis. Each authentication realm can advertise the
charges associated with obtaining the network access. Click Create, the Create Plan Information form is displayed. Update the
following plan information.
> Language
» Currency
> XML content
- Click OK.

e  Operator Icon: A maximum of two icons can be uploaded for an operator profile. The maximum size of an icon can be upto 64 KB.
Select the Language, click Browse to select an icon, and click Add.

e  Terms Conditions: Allows to communicate the terms and conditions of the Wi-Fi services. Updated terms and conditions can also be
communicated to existing service users. Update the following information.

- File Name
- Time Stamp
5. Click OK.
NOTE

You can also edit, clone, and delete a Hotspot 2.0 WLAN profile by selecting the options Configure, Clone, and Delete respectively, from
the Wi-Fi Operator tab in the Hotspot 2.0 window.
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Creating a Hotspot 2.0 Identity Provider

The Hotspot 2.0 Identity provider provides authentication, accounting and online sign-up service. There can be one or more identity providers per
Hotspot 2.0 access WLAN.

To configure the Hotspot 2.0 Identity Provider, go to Services > Hotspot & Portals > Hotspot 2.0 > Identity Provider and click Create. The Create
Hotspot 2.0 Identity Provider page is displayed. Configure the following details to create a Hotspot 2.0 Identity Provider:

1.
2
3.
4

5.

Network Identifier

Online Signup and Provisioning
Authentication

Accounting

Review

Configure the Hotspot 2.0 Identity Provider

1.

2.

On the menu, click Services > Hotspot & Portals > Hotspot 2.0 > Identity Provider to display the Identity Provider window.

FIGURE 48 Hotspot 2.0: Identity Provider

© AllNew Anslytics

o < wi-FiOperator

# Crsto | Contire | (7] Clone | Dette al co

System

ORGANIZATION

System /A

System NiA

system /A

System Operstor

Identity Provider

+ cruste

HHBRHE

DETAILS

In the Organization tab, select the zone for which you want to create the Identity Provider portal.
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. . . o Crente
In the Identity Provider tab, click

FIGURE 49 Creating a hotspot 2.0 Identity Provider

icon to display the Create Hotspot 2.0 Identity Provider dialog box.

Create Hotspot 2.0 Identity Provider

Network ldentifier | & 3>

Name: (O]

Description:

PLMNs: ~ MCC LIE

Realms: T

Encoding: | RFC-4282

EAP Methods:

# #2 #3 #

EAP Method: | N/A

Name a Encoding EAP Methods
Home Ols;  Mame Length Organization 1D
5Hex
Name a Length

+ Add

+ Add

»® Cancel

= Add ¥ Cancel

% Cancel

Next Cancel

Configure the following sections to create a Hotspot 2.0 Identity Provider:
a. Network Identifier

b.  Online Signup and Provisioning

c. Authentication

d. Accounting

e. Review

RUCKUS SmartZone (ST-GA) Guest Access Guide, 7.0.0
Part Number: 800-73364-001 Rev A



Working with Hotspots and Portals
Working with Hotspot 2.0 Services

Network Identifier

1. Complete the following fields:

FIGURE 50 Create Hotspot 2.0 Identity Provider - Network Identifier

Create Hotspot 2.0 Identity Provider

Network |dentifier | 3 > > EY

Name: (D]

Description:

PLMNs: ~ MCC G
4+ Add 3 Cancel

Realms: TR = Add  » Cancel

Encoding: | RFC-4282

EAP Methods:

#1 #2 #3 #

EAP Method: | N/A

Name & Encoding EAP Methods
Home Ols;  Mame Length Organization 1D
=+ Add ¥ Cancel
Name & Length Organization D

Next Cancel
e Name: Enter a name or this network identifier profile.
e  Description: Enter a description for the network identifier profile.
®  PLMNs: Each record contains MCC and MNC.
Add
Complete the following fields and click + Acc icon to add the PLMNSs. The configured information will be displayed in a table

below the PLMNs field.

- MCC: Set the correct country code for the geographical location. This is required when the controller sends MAP authentication
information. Type the mobile country code digits. Decimal digit strings with maximum length of 3 and minimum length of 2.

- MNC: Set the mobile network code based on the geographical location. This is required when controller sends MAP
authentication information. Type the mobile network code digits. Decimal digit strings with maximum length of 3 and minimum
length of 2.
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2.

Realms: List of NAI realms corresponding to service providers or other entities whose networks or services are accessible via this AP.
Up to 16 NAl realm entries can be created. Each NAI realm entry can contain up to four EAP methods.

Adld
Complete the following fields and click F Acc icon to add the Realms. The configured information will be displayed in a table
below the Realms field.

- Name: Enter a name.

- Encoding: Choose between RFC-4282 and UTF-8.

- EAP Methods: Choose the EAP Methods from the drop down list. You can select four EAP Methods, click #1, #2, #3, or #4 to
configure the EAP Methods for each choice.

Home Ols: Organization Identifier (Ol) is a unique value assigned to the organization. User can configure a maximum of 12 Ol values
and can adjust the order since the AP takes only 3 Ols in the beacon.

Add
Complete the following fields and click * Adc icon to add the Home Ols. The configured information will be displayed in a table
below the Home Ols field.

- Name: Enter a name.
- Length: Choose between 3 Hexadecimal or 5 Hexadecimal.
- Organization ID: Enter organization ID in the XX-XX-XX format for 3 Hexadecimal or XX-XX-XX-XX-XX format for 5 Hexadecimal.

Click Next.
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Online Signup and Provisioning

1. Complete the following fields:

FIGURE 51 Create Hotspot 2.0 Identity Provider - Online Signup and Provisioning

Create Hotspot 2.0 Identity Provider

Network Identifier & | Online Signup & Provisioning |3 > 3>

Enable Online Signup & Provisioning

Service URL] This field is required

s required
is required

Provisioning Options

Provisioning Service: * External Service URL: | ':E:‘

Provisioning Protocol: {{_Jslid} oma-Dm soAP—)(ML

Online Signup Options

05U NAI Realm: | Mo data available | (O]

Single S51D NAI:

Common Language lcon: Browse

Language Friendly Mame Description lcan

05U Service Description:
English Browse =k Add » Cancel

Language & Friendly Name Description

Whitelisted Domains: * Domain Name 4+ Add X Cancel

Domain Name a

Back Next Cancel

e  Provisioning Options tab, complete the following fields:
- Provisioning Service.

External Service URL: Enter the external OSU server URL.

The provisioning service is responsible for any subscription provisioning process in which messages are communicated between

the UE and the SZ resulting in a PPS-MO provisioned into the UE. The provisioning supports both SOAP-XML and OMA-DM as
communication protocols for the process based on the initial request coming from the UE. The provisioning service supports
sign-up; remediation and policy update flows where the UE is provisioned with a full PPS -MO or only with internal node/s of
the PPS-MO. Administrator can only set External Internal Provisioning Services, where the administrator is required to fill the
external OSU server URL.

- Provisioning Protocol: Switch ON communication protocols OMA-DM or SOAP-XML.

e  Online Signup Options tab, complete the following fields:
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2.

OSU NAI Realm: Select from the drop down list.

This configuration is only for External Provision Service. In case of Internal Provisioning Service, the NAI realm should be
configured per authentication service, which is available during on-boarding.
Single SSID NAI: Enter the SSID.

This configuration is for enabling single SSID for WLAN profile, The NAI length can have a maximum of 255 charecters.
Common Language Icon: Click Browse to upload the language icon.

This is the default icon presented in the device for this identity provider in case the device does not find any match for other
icons per language in the table.

OSU Service Description: This configures the friendly name, description and icon per language. This information is presented on
the device when it receives ANQP message which includes OSU providers. Friendly names, which are required to be part of the
OSU certificate is automatically populated in this table. In case description is also included in the OSU certificate it is
automatically populated into the table. Administrators are required to set the matched icon per language as included in the OSU
certificate.

Complete the following fields and click *F Add icon to add the OSU Service Description. The configured information will be
displayed in a table below the OSU Service Description field.

»  Language: Select the language from the drop down list.
» Friendly Name: Enter the name.

> Description: Enter the description.

> Icon: Click Browse to upload the icon.

Cancel
Click x icon to exit from the creating OSU Service Description. To delete the OSU Service Description, select the
1 pul fal
Friendly Name and click iy Delete Icon.
Add
Whitelisted Domain: Add the domain names and click ¥ Ace icon to add the External Portal domain.

Click Next.
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Authentication

1.

Complete the following fields:

FIGURE 52 Create Hotspot 2.0 Identity Provider - Authentication

Create Hotspot 2.0 Identity Provider
Network |dentifier &  Online Signup & Provisioning 3| Authentication |3 Accounting < Review

Authentication Services for Access WLAN

=+ Create

Realm Protocol Auth Service Dynamic VLAN ID
Mo Match MA MA-Disabled A
Unspecified MA MA-Disabled N/A

Mote: If device onboarding was done with credential type "remote’, then map your 'realm’ value to its respective authentication service PLUS define 'Unspecified’ realm & map it to

corresponding authentication service to properly handle legacy {(non-Hotspot 2.0) devices.

= Crests
Click - Icon to display the Create Realm Based Authentication Sevice dialog box.

FIGURE 53 Create Realm Based Authentication Sevice

Create Realm Based Authentication Service

Realm:

Service: | Mo data available ==

Dynamic VLAN 1D:
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Complete the following fields:
o  Realm: Enter the realm information to configure the realm mapping to the authentication service.

e  Service: Select the service from the drop down list to map the realm to an external RADIUS server which should be pre-configured.

To create a realm service, click + icon to display the Create Authentication Service dialog box. Create an authentication service,
refer to Creating Realm Based Authentication Profile from the Security Guide.

Click d Icon to edit the selected realm service.

e  Dynamic VLAN ID: Enter the VLAN ID.
To modify the realm, select the realm from the table and click Configure Icon.

To delete the realm, select the realm from the table and click Delete Icon.

2. Click Next.
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Accounting

1.

This feature is OFF by default, turn it ON to enable accounting and to display the table.

FIGURE 54 Create Hotspot 2.0 Identity Provider - Accounting

Create Hotspot 2.0 Identity Provider

Network |dentifier %  Online Signup & Provisioning 3  Authentication | Accounting |® Review

Enable Accounting

Accounting Services for Access WLAN

+ Create

Realm Protocol Accounting Service
Mo Match NA NA-Disabled
Unspecified MA MA-Disabled

Note: A realm to service mapping define the accounting service for each of the realm specified in this table. When the accounting service for a particular realm is 'NA’, then accounting is
disabled.

=+ Creste
Click " conto display the Create Realm Based Accounting Service dialog box.

FIGURE 55 Create Realm Based Accounting Service

Create Realm Based Accounting Service

Realm:

Service: | Mo data available ==
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Complete the following fields:

e  Realm: Enter the realm information.

If the authentication's realm is set as remote credential type, administrator should set this realm here to the customer's external

accounting server.

e  Service: Select the service from the drop down list.

To create a realm service, click + icon to display the Create Accounting Service dialog box. Create an authentication Service, refer

to Creating Proxy Accounting AAA Servers from the Security Guide.

Click 4 Icon to edit the selected realm service.
To modify the realm, select the realm from the table and click Configure Icon.
To delete the realm, select the realm from the table and click Delete Icon.

2. Click Next.

Review

Review the configuration on the page before committing the changes to the server. Click OK to create the Hotspot 2.0 Identity Provider.
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Network Identifier

Name: test

Description:
PLMMNs:
123
Realms:
test
Home Ols:
tst

Enable Online Signup &

Provisioning Options

Online Signup Options

05U MAI Realm

Provisioning Service:

Provisioning Protocol:

Single 551D NAI:

Common Language |con:

<  Online Signup & Provisioning

Provisioning

External Service URL:

OMA-DM

Create Hotspot 2.0 Identity Provider

133

RFC-4282

5 Hex

https://test.com

SOAP-XML

;| test

asaddas

=+ Add

05U Service Description:

English

% Authentication 9 Accounting =

Review

0x00 0200 0x00 0x00 0x00

NOTE

You can also edit, clone and delete a Hotspot 2.0 WLAN profile by selecting the options Configure, Clone, and Delete respectively, from
the Identity Provider tab in the Hotspot 2.0 window.
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Creating a Hotspot 2.0 Venue Profile

The Hotspot 2.0 technology allows users to seamlessly roam between the provider's home Wi-Fi network and the visited Wi-Fi network in a
different location. A Wi-Fi provider can partner with several roaming partners to provide Wi-Fi access to partner's subscribers. Public venues such as
institutions, restaurants, and stadiums are considered roaming partners.

1.  On the menu, click Services > Hotspots & Portals > Hotspot 2.0 to display the Hotspot 2.0 window.
FIGURE 57 Hotspot 2.0 - Venue Profiles

# |+ Monitor &5 Network 0 security & Services & Administration * nu © AllNew Analytics

GuestAccess  Hotspot(WISPr)  Hotspot20  WebAuth  UABlackiist  Portal Detection & Suppression  WeChat

€ WLAN Profile

“| & Create search table Q o6

Name & Descriptior Last Modified On Last Modified B

ORGANIZATION
o

Venue profiles

AISHZD AP
R - o+ Create search table Q <%

Last Modified By

MOURUA

No data 1

2. Inthe Organization tab, select the zone for which you want to create the Hotspot 2.0 Venue Profiles.

+ Creste
3. Inthe Venue profiles, click = Icon to display the Hotspot 2.0 Venue Profiles dialog box.

FIGURE 58 Creating a Hotspot 2.0 Venue Profile

Create Hotspot 2.0 Venue Profile

Name:
Description:
Venue
Venue Names: + Create

Language & Name URL List

Venue Category: Group: | Unspecified | Type: | Unspecified
WAN Metrics: Downlink Speed: kbps
Uplink Speed: kbps
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4. Complete the following fields:
e Name: Enter a name for this venue profile. This name identifies the venue profile when assigning an H52.0 service to a H52.0 venue.

o  Description: Enter a description for the venue profile.

.| Creste )
e Venue Names: Select the venue from the table or to create a new venue, click - Icon to display the Create Venue Names

dialog box.

- Venue Names: Select the language from the drop down list.
- Name: Enter a name for the new venue.
- URL: Enter additional URLs to the venue name and click Add. The URL can have a maximum of 254 charecters. A maximum of
four venue URLs can be mapped to a venue name.
- Click OK.
e Venue Category: Select venue group from the drop down list and venue type as defined in IEEE802.11u, Table 7.25m/n.
o  WAN Metrics: Enter information about the WAN link connecting an IEEE 802.11 access network and the Internet; includes uplink/

downlink speed estimates.
Select the operator profile. This name identifies the service operator when assigning an HS2.0 service to a H52.0 WLAN.
5. Click OK.
NOTE

You can also edit, clone and delete a Hotspot 2.0 venue profile by selecting the options Configure, Clone and Delete respectively, from
the Venue Profile tab in the Hotspot 2.0 window.

Creating a Web Authentication Portal

Web Authentication (also known as a “captive portal”) redirects users to a login web page the first time they connect to this WLAN, and requires
them to log in before granting access to use the WLAN.

1. Onthe menu, click Services > Hotspots & Portals > Web Auth to display the Web Auth window.

FIGURE 59 Web Auth
# |#”* Monitor &% Network U Security & Services & Administration * search menu @ AllNew Analytics
GuestAccess  Hotspot (WISPr)  Hotspot20 ~ WebAuth  UABlackiist  Portal Detection & Suppression  WeChat
c< Q c®
Name a Description
z ~ DB
£ + A aish N/A
5
g = A AISHWEB AUTH N/A
+ [D&)JL
5 (D) aish web auth N/A
+ (D PART
—— web N/A
- @ .
+ B
~ B
+ (D& g
=) 3
HZDA - qd
4records 1 2

2. Inthe Organization tab, select the zone for which you want to create the Web Auth.
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3.

FIGURE 60 Creating a Web Authentication Portal

Click Create to display the Create Web Authentication Portal dialog box.

General Options

Portal Mame:
Portal Description:

Language:

Redirection

Start Page:

Web Authentication

Web Portal Logo:

Web Portal Title:

User Session

Session Timeout

Grace Period

Create Web Authentication Portal

English

After user is authenticated,

#) Redirect to the URL that user intends to visit.

Browse

Redirect to the following URL:

1440 Minutes (2-14400)
&0 Minutes (1-14399)

Cancel
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4. Complete the following fields:
e  General Options

- Portal Name: Type a name for the hotspot service portal that you are creating.
- Portal Description: Type a short description of the hotspot service portal.
- Language: Select the display language that you want to use on the web authentication portal.

e  Redirection (Select where to redirect the user after successfully completing authentication.)
- Redirect to the URL that user intends to visit: Allows the guest user to continue to destination URL without redirection.
- Redirect to the following URL: Redirect the user to a specified web page (entered into the text box) prior to forwarding to the
destination URL. When a guest user lands on this page, the guest pass expiration time is displayed.
Enter a domain name or IP address to which to be redirected.
e  Web Authentication

- Web Portal Logo: By default, the web portal page displays the Ruckus logo. To use your own logo, click the Browse button, select
your web portal logo (recommended size is 138 x 40 pixels, maximum file size is 20 KB), and then click Open.
- Web Portal Title: Type your own web portal title text or accept the default portal title text (Welcome to the Web Authentication
login page).
e  User Session

- Session Timeout: Set a time limit (in minutes) after which users will be disconnected from the hotspot service and will be
required to log in again.

- Grace Period: Set the time period (in minutes) during which disconnected users are allowed access to the hotspot service
without having to log in again.

5.  Click OK.

NOTE
You can also edit, clone, or delete a Web Authentication by selecting the options Configure, Clone, and Delete, respectively, from the
Web Auth window.

Creating a UA Blacklist Profile

The controller automatically blocks certain user agents (or software used by a user) from accessing hotspots provided by controller-managed APs.
When the controller blocks any of these user agents, an error message appears on the user device. You can add to or remove user agents from this
blacklist.
Following are some of the blocked user agents:

e  ZoneAlarm

e  VCSoapClient

e  XTier Netldentity

e  DivX Player

e  Symantec LiveUpdate

e  Windows Live Messenger

e  Stublnstaller

e  windows-update-agent

e  Windows Live Essentials

e  Microsoft Dr. Watson for Windows (MSDW)
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Avast Antivirus Syncer

Microsoft Background Intelligent Transfer Service (BITS)

Google Update
TrendMicro client

Skype WISPr

To blacklist a user agent profile:

70

1.

2.

On the menu, click Services > Hotspots & Portals > UA Blacklist to disaply the UA Blacklist window.

FIGURE 61 UA Blacklist

E | Monitor i Network U Ssecurity

«f services

& aon

UABlacklist

GuestAccess  Hotspot (WISPr)  Hotspot 20 Web Auth

VCSoapClient pClient

e Essentials

& Messenger

indoy
XTier Net *XTier Netidentity*
ZoneAlarm IZoneAlarm.”

UABlacklist

+ Create

Name

DIvX Player DV

Google Update Google Update”
Microsoft BITS “Microsoft BITS”
MSDW TMSDW.

Skype WISPr “[sSlkype”
Stublnstaller rstublnstaller™
Symantec LiveUpdate rsymantec LiveUpdate:
Syncer rsyncer”
TrendMicro client

ndows [LIjive [Ee]ssentials™

Portal Detection & Suppression  WeChat

- DivX Player
-Google Update
- Microsoft BITS
-MSDW

- Skype WISPr

-Stubinstaller

~TredMicro client TMUFE

-VCSoapClient

~Windows Live Essentials
~Windows Live Messenger
-windows-update-agent

~XTier Netidentity

2 2
503 Un-authorized protocol detected

503 Un-authorized protocol detected

503 Un-authorized protocol detected

503 Un-authorized protocol detected

503 Un-authorized protocol detected

503 Un-authorized protocol detected

503 Un-authorized protocol detected - Syma
503 Un-authorized protocol detected - Sy,
503 Un-authorized protocol detected

503 Un-authorized protocol detected

503 Un-authorized protocol detected

503 Un-authorized protocol detected

503 Un-authorized protocol detected

503 Un-authorized protocol detected

503 Un-authorized pretocol detected

-ZoneAlarm

search table Q cu

MOU 1PN

15 records 1

+ Create

Click ™ lconto display the Create UA Blacklist Profile dialog box.

FIGURE 62 Creating a UA Blacklist Profile

Name:

User Agent Pattern:

Error:

Error Message:

I
I

[ ]

Create UA Blacklist Profile

Cancel
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3. Complete the following fields:
o  Name: Enter the name of the user agent.
e  User Agent Pattern: Type the agent pattern.
e  Error: Specify the error message number.
o  Error Message: Specify the error message.
4. Click OK.
NOTE

You can also edit, clone, and delete a UA blacklist profile by selecting the options Configure, Clone and Delete respectively, from the UA
Blacklist window.

Creating a Portal Detection and Suppression Profile

To restrict an unauthorized user in a walled garden, a service operator must set defined policy rules by creating a portal detection and suppression
profile.

1. Onthe menu, click Services > Hotspots & Portals > Portal Detection & Suppression to display the Portal Detection & Suppression
window.

FIGURE 63 Portal Detection & Suppression

# | Monitor &3 Network U security & Services & Administration * © All New Analytics

GuestAccess  Hotspot (WISPr)  Hotspot2.0  WebAuth  UABlacklist  Portal Detection & Suppression  WeChat

Name a Description
jilani-1 System default portal detection and suppression profile.

System Default System default portal detection and suppression profile.

ORGANIZATION

MO PN

2. Inthe Organization tab, select the zone for which you want to create the Portal Detection.
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. + Craat= . . . .
3. Click Icon to display the Portal Detection & Suppression dialog box.

FIGURE 64 Creating Portal Detection Profile

Create Portal Detection Profile

General Options

Name: ‘

Description: ‘

Portal Detection Patterns

=+ Create

Name User Agent Pattern HTTP Code HTTP Response Body
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4. Complete the following fields:
e  General Options

- Name: Enter a policy list name.
- Description: Enter description for the policy list.

e  Portal Detection Patterns: Select the portal detection patterns from the table or create a portal detection pattern as show below.

o Crest=
a. Click = Icon to display the Create Portal Detection Pattern dialog box.

FIGURE 65 Creating Portal Detection Pattern

Create Portal Detection Pattern

Hame:

User Agent Pattern:

| |
| |
HTTP Code: | |
| |

HTTP Response Body:

b. Complete the following fields:

- Name: Enter the name of the portal detection pattern.
- User Agent Pattern: Enter the user agent pattern.

NOTE

The user agent pattern must follow a regular expression format, starting and ending with .* (for

example, .*Android-WiFi.*). The default Captive Portal Detection may not support all the Android devices and
the new Microsoft phone if different user agent patterns are used. In this case, new rules must be created to
cover such patterns. Using an improper user agent pattern may impact browser behaviors.

- HTTP Code: Enter the code.

NOTE
The HTTP code range must be from 100 through 599.

- HTTP Response Body: Eenter the HTML string.

c. Click OK.
NOTE
You can also edit, clone, and delete a Portal Detection Patterns by selecting the options Configure, Clone, and Delete
respectively, from the Portal Detection Patterns tab.
5. Click OK.

RUCKUS SmartZone (ST-GA) Guest Access Guide, 7.0.0
Part Number: 800-73364-001 Rev A 73



Working with Hotspots and Portals
Creating a WeChat Portal

NOTE
To select a Portal Detection Pattern profile, Bypass CNA must be enabled in the WLAN configuration page. Use Bypass CNA to enable or
disable Portal Detection Service for HotSpot, Web Authentication, and Guest Access WLAN.

NOTE
You can also edit, clone, or delete a portal detection and suppression by selecting the options Configure, Clone, and Delete respectively,
from the Portal Detection & Suppression window.

VIDEO
Portal Detection and Suppression Overview. This video provides a brief overview of Portal Detection and Suppression.

| Portal Det ppression

Click to play video in full screen mode.

Creating a WeChat Portal

WeChat is a mobile app from Tenecent that enables its users to call and send text messages to one another. If you have WeChat users on the
network and you want your WLANSs to support WeChat services, you can create a WeChat portal that WeChat users can use.

A WeChat portal defines the third party authentication server, also known as the equipment service provider (ESP) server, to which the controller
will forward all WeChat authentication requests from wireless devices that are associated with controller-managed APs. In turn, the third party
authentication server will forward these authentication requests to the WeChat server.

1. On the menu, click Services > Hotspots & Portals > WeChat to display the WeChat window.
FIGURE 66 WeChat

#« | Monitor o Network U security ot Services & Administration * © All New Analytics

GuestAccess  Hotspot (WISPr)  Hotspot2.0  WebAuth  UABlacklist  Portal Detection & Suppression ~ WeChat

search table Q cu

ORGANIZATION

MOl 1PIA

o data 1

2. Inthe Organization tab, select the zone for which you want to create the WeChat portal.
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. & Creste . .
3. Click Icon to display the Create WeChat Portal dialog box.

FIGURE 67 Creating a WeChat Portal

Create WeChat Portal

General Options

Portal Settings

Whitelist

DNAT Port Mapping

N e
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4. Complete the following fields:

e  General Options

FIGURE 68 Create WeChat Portal - General Options

Create WeChat Portal

General Options

Name:

Description:

- Name: Type a name for the portal that you are creating.
- Description: Type a short description of the portal.

e  Portal Settings

FIGURE 69 Create WeChat Portal - Portal Settings

Create WeChat Portal

76

General Options

Portal Settings

Authentication URL:
DMNAT Destination:
Grace Period: | 60 Minutes (1-14393)

Blacklist:

Authentication URL: Enter the authentication interface URL on the third party authentication server. When a managed AP
receives a WeChat logon request from a client device, it will send the request to this authentication URL and get the
authorization result.

DNAT Destination: Enter the DNAT destination server address to which the controller will forward HTTP requests from
unauthenticated client devices. The DNAT destination server and the authentication server (above) may or may not be the same
server.

Grace Period: Enter the number of minutes during which disconnected users who were recently connected will be allowed to
reconnect to the portal without needing to re-authenticate. The default grace period is 60 minutes (range is between 1 and
14399 minutes).

Blacklist: Enter the network destinations that the controller will automatically block associated wireless clients from accessing.
Use a comma to separate multiple entries.

Whitelist
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FIGURE 70 Create WeChat Portal - Whitelist
Create WeChat Portal
General Options
Portal Settings
Whitelist
Whitelist: © Walled Garden Entry =+ Add Import CSV ® Cancel
Walled Garden Entry
Mo data 1
Unauthenticated users are allowed to access the following destinations.
h special regular expression like
- “.amazon.com
Lom

- Walled Garden Entry: Enter the network destinations that the controller will automatically allow associated wireless clients to
access. You can add a single entry or multiple entries.

To add a single entry, enter the entry in Wall Garden Entry field, and then click + Icons. The entry you added appears in the
table below. To add multiple entries, in a comma-separated value (CSV) file, type all the network destinations that you want to
add to the whitelist, and then save the CSV file. In the Whitelist section, click Import CSV, and then select the CSV file you
created. Click Open. The entries in the CSV file are added to the whitelist.

o  DNAT Port Mapping
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FIGURE 71 Create WeChat Portal - DNAT Port Mapping

Create WeChat Portal

General Options
Portal Settings
Whitelist

DMAT Port Mapping

DNAT Port Mapping: ~ Source Port Dest Port
=+ Add 3 Cancel
Source Port a Dest Port
80 80

Specify at least one pair of source-to-destination port mapping. To add a port mapping, enter the source and destination ports in the

fields Source Port and Dest Port, and then click * Icon. The AP will use this information to drop or forward HTTP requests from
associated clients to specified ports on the DNAT server. For example, if an HTTP request from a wireless client does not originate
from the specified source (from) port, the AP will discard the HTTP request. By default, a port mapping of 80-80 (source-destination)
exists.

5. Click OK.

NOTE
You can also edit, clone and delete a WeChat service portal by selecting the options Configure, Clone and Delete respectively, from the
WeChat window.

Creating Network Segmentation Profile on the vSZ
Controller

Network Segmentation was designed specifically to target Multi Dwelling Unit (MDU) deployments. Network Segmentation is currently using
external Dynamic Pre shared Key (DPSK) to place a single tenant and their devices into their own individual VXLAN (iLAN).

Data Plane (DP) will play the role of Home DP or Partner DP. Each DP plays the home DP role and has its own VXLAN Network Identifier (VNI) range.
Home DP facilitates MDU UE, connect with each other based on the same VNI number.

1. On the menu, click Services > Hotspots & Portals > Network Segmentation > Network Segmentation Profiles to display the Network
Segmentation Profiles.
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FIGURE 72 Network Segmentation Profiless
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2. Click Icon to display the Create Network Segmentation dialog box.

FIGURE 73 Edit Network Segmentation Groups in SmartZone User Interface

Create Network Segmentation

Name:

Data Plane

+ Add

Data Plane & VNI Range DHCP Profile DHCP Pool MA

Next

Cancel
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3. Complete the following fields under the General dialog box:

e Name: Enter a network segmentation profile name.

Add
e Data Plane: Select the data plane from the table or create a data plane. Click + Acc Icon to display the Create Data Plane Relation

dialog box.

FIGURE 74 Create Data plane Relation

Create Data Plane Relation

Normol Data [ .
Plane :

WVHI Range:

Complete the following fields:

80

Normal Data Plane: Select the data plane from the drop down list.
VIN Range: Enter the VNI range; ensure your VNI range is large enough to accommodate all units in the property. Each unit gets
its own unique VNI.

NOTE
The VNI value can be mapped from the client data in Troubleshooting from the Management Guide, if user is having
issues in selecting the VNI range.

DHCP Profile: Select the DHCP profile from the drop down list or click + to create a DHCP Profile, refer to Creating Profile-
based DHCP from the Traffic Management Guide.

DHCP Pool: Select the DHCP pool from the drop down list or click + to create a DHCP pool, refer to Creating Profile-based
DHCP from the Traffic Management Guide.

NAT Profile: Select the NAT profile from the drop down list or click * to create a NAT profile, refer to Creating Profile-based
NAT from the Traffic Management Guide.

NAT Pool: Select the NAT pool from the drop down list or click + to create a NAT pool, refer to Creating Profile-based NAT from
the Traffic Management Guide.

NOTE
By default, the Redundant Data Plane is switched OFF. Switch it ON to enable the Redundant Data Plane.
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NOTE

You can also edit and delete a Data Plane by selecting the options Configure and Delete respectively, from the Data Plane
tab.

4. Click Next.
5. Complete the following fields under the Wireless dialog box:

By defaut, the Wireless option is disabled. Switch ON to enable the Wireless option.

FIGURE 75 Select SSID (wireless) for Network Segmentation

Edit Network Segmentation

General Wireless B AP Wired B Switch [:]
L Prof oup

0 Swite

» Name > ® 55D
« Data Plane @ WLANS

> Review

(on @I

@ Select one SSID to be used for the network segmentation.

Q on
[} 1P ipur U ipur
1 records 1
Selected SSI0: MDUENIPUN
@ Select WLANSs from different zones to be part of the network segmentation.
Select Wlans [Domain-Zone-WLAN-SSID) Selected Wlans (Domain-Zone-WLAN-SSID)

Nipun-Nipun-MDU-MDU-MOU@NIPUN

®  SSID: Select the SSID for Network Segmentation from the drop down list.

The selected SSID will be displayed in the Selected SSID field.
e  WLAN: Select WLANSs (wireless) for Network Segmentation.

6. Click Next.
7. Complete the following fields under the AP Wired dialog box:

By defaut, the AP Wired option is disabled. Switch ON to enable the AP Wired option.
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FIGURE 76 AP Wired Ethernet Profile
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Selected AP Groups (Domain-Zone-AP Group)

Mipun-Mipun-MDU-Real AP
Mipun-Mipun-MDU-defaut

3> Review

Cancel

o  Select the Ethernet profile: Select the ethernet profile from the drop down list or click * Icon to create an ethernet profile.

The selected SSID will be displayed in the Selected SSID field.
o  Select the AP group: Select the AP group from the table.

8.  Click Next.
9. Complete the following fields under the Switch dialog box:

By defaut, the Switch option is disabled. Switch ON to enable the Switch option.
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FIGURE 77 Switch
Edit Network Segmentation
General Wireless ™ AP wired L\/ Switch [C74
» Hame s O 0D » Ethemet Prol 3 e
» Data Plang 9 WLAN: & AP Groups
m Enable
o Select Switch Groups
Aovailable Switch Groups Selected Switch Groups
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- B -
@
¢ [ e -
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o  Select the Switch Groups: From the table, select the switch group which is to be added to the Network Segmentation group.

NOTE
To select the participated Switch Group for the segment profile, administrator can utilize the search function to filter out
the groups.

o  Select Distribution Switches: Select the distribution switch from the drop down list which is to be added to the Network
Segmentation group.

FIGURE 78 Select Distribution Switches

Edit Network Segmentation

General Wireloss ™ APWired (W switch ~
» Name 3 @SS » Ethemet P 0 Swi 3 Review
» Dada Planc & WiANs * AP Groups
@ Setup Distribution Switches
™
L
Select Distribution Switches! | 1
a @
METALXX-CORE-DNS [BC:T...  [SUCCESS) wDP-7-113-Two METALXCM...  300-399 41 10.10.41.1/255.255.255.0
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NOTE
VXLAN only support on higher end switches such as ICX 7850, 7650 and 7550 model with router image, so distribution
Switch should use the abovementioned ICX models.

To configure the distribution switches, select the switch from the table and click Configure Icon to display the Edit Distribution
Switch dialog box.

FIGURE 79 Configure Distribution Switch

Edit Distribution Switch: NET41XX-CORE-DIS

Data Plane: | vDP-7-113-Two (:m pataBlans Hecindanoy,
VLAN List:
* Loopback Interface ID:
Loopback Interface IP:
Loopback Interface Subnet Mask:
Keep alive: 5

Retry times: 3

Available Access Switches 7] Selected Access Switches

NET41XX-MDU1 [D4:C1:9E:10:A1:00]
NET41XX-MDU-2 [C0:C5:20:B0:C4:F5)

Complete the following fields:

Data Plane: Select the data plane.

VLAN List: Enter the VLAN List.

Loopback Interface ID: Enter the Loopback Interface ID.

Loopback Interface IP: Enter the Loopback Interface IP.

Loopback Interface Subnet Mask: Enter the Loopback Interface Subnet Mask.

Keep alive: Enter the keep alive time interval to enable data plane monitor status. This option is enabled, if the Data Plane
Redundancy is switched ON.

Keep alive value is restricted between the range of 1 - 20 seconds to check Data plane status by ICMP Ping.
Retry times: Enter the retry time interval to enable data plane monitor status. This option is enabled, if the Data Plane
Redundancy is switched ON.

Retry times is restricted between the range of 1 - 5 to check Data plane status retry times if no response.
Available Access Switches: The available access switches are displayed in the table.
Selected Access Switches: Select the access switch from the interface.
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Edit Distribution Switch: NET41XX-CORE-DIS

* Data Plane: | vDP-T-113-Two
] VLAN List:
Loopback Interface 1D:
Loopback Interface IP:
Loopback Interface Subnet Mask:
7] Keep alive: 5

?] Retrytimes: 3

(m Data Plane Redundancy

Available Access Switches 7] Selected Access Switches

Q

NET41XOCMDUT [D4:CIOE10A100) o e

NET41XX-MDU-2 [C0:C5:20:B0:C4:F5]

Cancel

- Data Plane Redundancy: Administrator can disable/enable site redundancy.

NOTE
The maximum size of redundancy server is seven.

- Distribution Switch and Data Plane communicate client VNI information via VXLAN Tunnel as follows:

a. Switch Client connect to Access Switch.

b. Access Switch connect to the Distribution Switch.

c.  Distribution Switch establish VXLAN tunnel to the Data Plane.

Switch Client management:

a. Distribution Switch use loopback interface connect to Data Plane interface.
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FIGURE 81 Loopback Interface Connect to Data Plane Interface

Available Access Switches

Data Plane:

VLAN List:

Loopback Interface 1D:

Loopback Interface IP:

Loopback interface Subnet Mask:

Keep alive:

Retry times:

2392-6110140-1

3001,3002

1

111110110113

255.255.255.0

10

3

Edit Distribution Switch: ICX7850-48C Router

m Data Plane Redundancy

+ Create

1 2392-6110140-a

Selected Access Switches

ICX7450-48P Switch [D4:C1.9E:06.2E:80]

Network Routing will be carried out between Distribution Switch loopback interface and Data Plane data interface.

Switch Client belonging to Access Switch should authenticate VLAN network.

Browser will re-direct to Web Authentication page.

After the Switch Client pass web authentication, the Distribution Switch forward the client traffic to Data Plane.

For the Network Segmentation function of Switch part, all devices between Distribution Switch and Data Plane must enable
the Jumbo mode. This includes the Distribution Switch itself and vSZ-D Data interface which belongs to the vSwitch on ESXi.
Otherwise, switch client will not be able to access the internet connection.

To enable the Jumbo mode, do the following:

»  On the menu, click Network > Wired > Switches to display the Switches window.
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FIGURE 82 Switches
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> Click Configuration > Configure to display Feature Configuration dialog box.
»  Switch ON to enable the Jumbo mode.

FIGURE 83 Feature Configuration

af rucwus
Feature Configuration - ICX7550-48P Router DS1
Swiich  ALCL R F A
w1 ICHTS-48P Rowter 051
[ o e
> Click OK.

f.  The data plane detects the VXLAN.
g. Data Plane provide the DHCP/NAT service according to Switch Client VNI information.

o  Setup Access Switches: Select the access switch and apply the setting.
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FIGURE 84 Setup Access Switches

@ setup Access Switches

Uplink Port:  1/2/1 VLAN ID:
Web Auth Page Settings

Header:  Welcome 1o Ruchkus Wireles

Footer:

ICXT150-48 [SUCCESS] CX75

Title: | Web Authentication Password Label:  Password Button Text: Log

Complete the following fields:

Back

Apply to all

Next Cancel

- You can choose multiple switches as access switches, administrator can unify the WebAuthPortal settings by clicking the Apply

to all. The access switch will share the same configurations instead of configuring each switch manually.

10. Click Next.

11. Cross check the data in the Review page.
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FIGURE 85 Review Page
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12. Click OK.

From the table, select the network segmentation profile to view the profile settings details.
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FIGURE 86 Network Segmentation Profile Settings
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Distribution Switches

Access Switches

Functions of Switches are as follows:
®  Access Switch provide Web Authentication Service and handles VLAN service.
e  Distribution Switch handles VNI/VLAN mapping and forward the traffic to Data Plane.
The data plane handles VNI and DHCP/NAT services.
When Switch Client access the internet by browser, most packets come back from gateway to the Data Plane. The Data Plane must add

VXLAN header and then forward to the Distribution Switch.

NOTE
The maximum packet length between Distribution Switch and Data Plane is 1564 (1514 general +50 VXLAN header)

NOTE
You can also edit and delete a Network Segmentation Profiles by selecting the options Configure and Delete respectively, from the

Network Segmentation Profiles window.

Ethernet Profiles

1. On the menu, click Services > Hotspots & Portals > Network Segmentation > Ethernet Profiles to display the Ethernet Profiles window.

FIGURE 87 Ethernet Profiles
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+ Crept=
2. Select the ethernet profile from the table or create a ethernet profile, click = Icon to display the Create Network Segmentation
Ethernet Port dialog box.

FIGURE 88 Create Network Segmentation Ethernet Port

Create Network Segmentation Ethernet Port

General Options

Ethernet Port Usage

Port Rate Limiting: Uplink: Only User port Rate Limit is supported for the wired clients. Firewall Profile Rate Limit

Name:

Description:

User Side Port: 8

and Device policy Rate Limit features are not supported for the wired clients.
Downlink: {{ Jeid

3. Complete the following fields:

e  General Options

Name: Enter the ethernet port name.
Description: Enter a short description of the ethernet port.
Type: Select from the drop down list.

e  Ethernet Port Usage

4. Click OK.

Access Network: Select from Default WAN, Local Subnet (LAN), or Tunnel Ethernet Port Traffic.

User Side Port: By default, this option is switched ON. Switch OFF to disable this option.

Number of clients allow to be connected: Enter the number of clients allowed to be connected.

Port Rate Limiting: Only User port Rate Limit is supported for the wired clients. Firewall Profile Rate Limit and Device policy Rate
Limit features are not supported for the wired clients.

Uplink: By default, this option is switched OFF. Switch ON to enable uplink limit. You can enter the limit between 1-1000 mbps.

Downlink: By default, this option is switched OFF. Switch ON to enable downlink limit. You can enter the limit between 1-1000
mbps.
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NOTE
You can also edit, clone, or delete a Ethernet Profiles by selecting the options Configure, Clone, and Delete, respectively, from the
Ethernet Profiles window.
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